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1.  Introduction 
 

1.1 Additional Module STEEL SANS 

The South African National Standard SANS 10162-1 determines rules for the design, analysis 
and construction of steel buildings in South Africa. With the add-on module STEEL SANS from 
the DLUBAL SOFTWARE GMBH company all users obtain a highly efficient and universal tool to de-
sign steel structures according to this standard. 

All typical designs of load capacity, stability and deformation are carried out in the module 
STEEL SANS. Different actions are taken into account during the load capacity design. It is also 
possible to choose among the interaction formulae mentioned in the code. The slenderness 
types of the cross-sections are taken into account automatically. Thus, it is possible to check 
the limitation of the design capacity and of the rotational capacity due to local buckling for 
cross-section parts. STEEL SANS automatically calculates the limiting width-to-thickness ratios 
of compressed parts and classifies the cross-section. 

The sectional coordinate system in STEEL SANS is different from the indices used in the South 
African standard. It corresponds to the one used in RSTAB: The indices “y” and “z” refer to the 
axes in the cross-section plane as seen in the image to the left. 

For the stability design, you can determine for every single member or set of members wheth-
er buckling is possible in the direction of y-axis and/or z-axis. Lateral supports can be added for 
a realistic representation of the structural model. The specific ratios of slendernesses and criti-
cal stresses are automatically determined by STEEL SANS on the basis of the boundary condi-
tions. The location where the loads are applied, which influences the lateral torsional design, 
can be defined in the detailed settings.  

The serviceability limit state has become important for the static calculation of modern civil 
engineering as more and more slender cross-sections are being used. In STEEL SANS, load cas-
es, load combinations and result combinations can be arranged individually to cover the vari-
ous design situations. It is also possible to specify reference lengths and precambers for the 
design. 

If required, you can optimize the cross-sections and export the modified cross-sections to 
RSTAB. Using the design cases, you can design separate structural components in complex 
structures or analyze variants. 

STEEL SANS is an add-on module integrated in RSTAB. For this reason, the design relevant in-
put data is already preset when you have started the module. Subsequent to the design, you 
can use the graphical RSTAB user interface to evaluate the results. Finally, the design process 
can be documented in the global printout report, from the calculation of the internal forces to 
all design details. 

We hope you will enjoy working with STEEL SANS. 

Your DLUBAL Team 
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1.2 STEEL SANS Team 
The following people participated in the development of the STEEL SANS module: 

Program coordinators 
Dipl.-Ing. Georg Dlubal Dipl.-Ing. (FH) Younes El Frem 

Programmers 
Ing. Zdeněk Kosáček 
Dipl.-Ing. Georg Dlubal 
Dr.-Ing. Jaroslav Lain 
Ing. Martin Budáč 

Mgr. Petr Oulehle 
Dr.-Ing. Jaroslav Lain 
Ing. Zbyněk Zámečník 
Ing. Jakub Melka 

Library of cross-sections and materials 
Ing. Ph.D. Jan Rybín 
Stanislav Krytinář 

Jan Brnušák 
 

Design of program, dialog boxes and icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Testing and technical support 
Ing. Ph.D. Martin Čudejko 
Ing. Martin Hlavačka 
Dipl.-Ing. (BA) Markus Baumgärtel 
M.Sc. Sonja von Bloh 
Dipl.-Ing. (FH) Steffen Clauß 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Walter Fröhlich 

Dipl.-Ing. (FH) Wieland Götzler 
Dipl.-Ing. (FH) Ulrich Lex 
Dipl.-Ing. (BA) Andreas Niemeier 
Dipl.-Ing. (FH) Walter Rustler 
M.Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Lukas Sühnel 
Dipl.-Ing. (FH) Robert Vogl 

Manual 
Ing. Ph.D. Martin Čudejko 
Dipl.-Ing. (FH) Robert Vogl 

Bc. Chelsea Jennings 

1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation, and printout are described 
in detail in the manual of the main program RSTAB. The present manual focuses on typical fea-
tures of the add-on module STEEL SANS. 

The descriptions in this manual follow the sequence and structure of the module's input and 
results windows. The text of the manual shows the described buttons in square brackets, for 
example [View mode]. At the same time, they are pictured on the left. Expressions appearing 
in dialog boxes, windows, and menus are set in italics to clarify the explanations. 

At the end of the manual, you find the index. However, if you don’t find what you are looking 
for, please check our website www.dlubal.com where you can go through our comprehensive 
FAQ pages by selecting particular criteria. 

http://www.dlubal.com/
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1.4 Starting STEEL SANS 
RSTAB provides the following options to start the add-on module STEEL SANS. 

Menu 
To start the program in the RSTAB menu bar, click 

Add-on Modules → Design - Steel → STEEL SANS. 

 

Figure 1.1: Main Menu: Additional Modules → Design - Steel → STEEL SANS 
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Navigator 
You can also start the add-on module in the Data navigator by clicking 

Add-on Modules → STEEL SANS. 

 

Figure 1.2: Data Navigator: Add-on Modules → STEEL SANS 

Panel 
If results from STEEL SANS are already available in the RSTAB model, you can also open the de-
sign module in the panel: 

Set the relevant STEEL SANS design case in the load case list of the RSTAB toolbar. Then click 
the button [Show Results] to display the design criterion on the members graphically. 

When the results display is activated, the panel is available, too. Now you can click the button 
[STEEL SANS] in the panel to open the module. 

 
Figure 1.3: Panel button [STEEL SANS] 
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2. Input Data 
When you have started the add-on module, a new window opens. In this window, a Navigator 
is displayed on the left, managing the windows that can be currently selected. The drop-down 
list above the navigator contains the design cases (see chapter 7.1, page 52). 

The design relevant data is defined in several input windows. When you open STEEL SANS for 
the first time, the following parameters are imported automatically: 

• Members and sets of members 

• Load cases, load combinations, result combinations and super combinations 

• Materials 

• Cross-sections 

• Effective lengths 

• Internal forces (in background, if calculated) 

To select a window, click the corresponding entry in the navigator. To set the previous or next 
input window, use the buttons shown on the left. You can also use the function keys to select 
the next [F2] or previous [F3] window. 

Click [OK] to save the results. Thus you exit STEEL SANS and return to the main program. If you 
click [Cancel], you exit the module but without saving the data. 

2.1 General Data 
In window 1.1 General Data, you select the members, sets of members and actions that you 
want to design. The tabs are managing the load cases, load combinations, result combinations 
and super combinations for the different designs. 

 
Figure 2.1: Window 1.1 General Data 
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Design of 

 
Figure 2.2: Design of members and sets of members 

The design can be carried out for Members as well as for Sets of Members. If you want to design 
only selected objects, clear the All check box: Then you can access the text boxes to enter the 
numbers of the relevant members or sets of members. The list of the numbers preset in the 
field can be cleared by clicking the [Delete] button. Alternatively, you can select the objects 
graphically in the RSTAB work window after clicking []. 

When you design a set of members, the program determines the extreme values of the de-
signs of all members contained in the set of members and takes into account the boundary 
conditions of connected members for the stability analysis. The results are shown in the result 
windows 2.3 Design by Set of Members, 3.2 Governing Internal Forces by Set of Members, and 4.2 
Parts List by Set of Members. 

Click [New] to create a new set of members. The dialog box that you already know from RSTAB 
appears where you can specify the parameters for a set of members. 

2.1.1 Ultimate Limit State 

 
Figure 2.3: Window 1.1 General Data, Ultimate Limit State tab 

Existing Load Cases and Combinations 
This column lists all load cases, load combinations, result combinations and super combina-
tions created in RSTAB.  

Click [] to transfer selected entries to the list Selected for Design on the right side. You can also 
double-click the items. To transfer the complete list to the right, click []. 

To transfer multiple entries at once, select them while pressing the [Ctrl] key, as common for 
Windows applications. 

Load cases written in red like load cases 9 and 10 in Figure 2.3 cannot be designed: Those load 
cases are defined without any load data, or they contain only imperfections. When you transfer 
such a load case, a warning appears. 
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At the end of the list, several filter options are available. They will help you assign the entries 
sorted by load case, load combination, or action category. The buttons have the following 
functions: 

 
Select all cases in the list. 

 
Invert selection of load cases. 

Table 2.1: Buttons in tab Ultimate Limit State 

Selected for Design 
The column on the right lists the load cases, load and result combinations selected for design. 
To remove selected items from the list, click [] or double-click the entries. To transfer the en-
tire list to the left, click []. 

The design of an enveloping max/min result combination is performed faster than the design 
of all contained load cases and load combinations. However, the analysis of a result combina-
tion has also disadvantages: First, the influence of the contained loads is difficult to discern. 

Second, for the determination of the critical elastic moment for lateral-torsional buckling, the 
envelope of the moment distributions is analyzed, from which the most unfavorable distribu-
tion (max or min) is taken. However, this distribution only rarely reflects the moment distribu-
tion in the individual load combinations. Thus, in the case of a RC design, more unfavorable 
values for the critical elastic moment are to be expected, leading to higher ratios. 

Result combinations should be selected for design only for dynamic combinations. For "usual" 
combinations, load combinations are recommended. 

 

Result  
combination 
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2.1.2 Serviceability Limit State 

 
Figure 2.4: Window 1.1 General Data, Serviceability Limit State tab 

Existing Load Cases and Combinations 
This section lists all load cases, load combinations, result combinations and super combinations 
created in RSTAB. 

Selected for Design 
Load cases, load combinations and result combinations can be added or removed as described 
in chapter 2.1.1. 

The limit values of the deformations are controlled by the settings in the Details dialog box 
(see Figure 3.3, page 31) which you can call up by clicking the [Details] button. 

In the window 1.9 Serviceability Data, the reference lengths decisive for the deformation check 
are managed (see chapter 2.9, page 26). 
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2.2 Materials 
The window consists of two parts. In the upper part, all materials created in RSTAB are listed. In 
the Material Properties section, the properties of the current material, that is, the table row cur-
rently selected in the upper section, are displayed. 

 
Figure 2.5: Window 1.2 Materials 

Materials that will not be used in the design are dimmed. Materials that are not allowed are 
highlighted in red. Modified materials are displayed in blue. 

The material properties required for the determination of internal forces are described in chap-
ter 4.2 of the RSTAB manual (Main Properties). The material properties required for design are 
stored in the global material library. The values are preset (Additional Properties). 

To adjust the units and decimal places of material properties and stresses, select in the mod-
ule's menu Settings → Units and Decimal Places (see chapter 7.3, page 56). 

Material Description 
The materials defined in RSTAB are already preset, but it is always possible to modify them. To 
do this, click the material in column A. Then click [] or press function key [F7] to open the ma-
terial list. 

 
Figure 2.6: List of materials 
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According to the design concept of SANS 10162-1 [1], you can select only materials of the 
“Steel” category. 

When you have imported a material, the design relevant Material Properties are updated. 

If you change the material description manually and the entry is stored in the material library, 
STEEL SANS will import the material properties, too. 

Principally, it is not possible to edit the material properties in the add-on module STEEL SANS. 

Material Library 
Numerous materials are already available in the library. To open the corresponding dialog box, 
click 

Edit → Material Library 

or use the button shown on the left. 

 
Figure 2.7: Dialog box Material Library 

In the Filter section, Steel is preset as the material category. Select the steel grade that you 
want to use for the design in the list Material to Select. The corresponding properties can be 
checked in the dialog section below. 

Click [OK] or [↵] to transfer the selected material to window 1.2 of the module STEEL SANS. 

Chapter 4.2 in the RSTAB manual describes in detail how materials can be filtered, added or 
rearranged. 

You can also select material categories like Cast Iron or Stainless Steel. Please check, however, 
whether these materials are covered by the design concept of the Code [1].  
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2.3 Cross-Sections 
This window manages the cross-sections used for design. In addition, the window allows you 
to specify optimization parameters. 

Coordinate System 

The sectional coordinate system in STEEL SANS is different from the indices used in the South 
African standard. It corresponds to the one used in RSTAB (see image in Figure 2.8): The y-axis 
is the major principal axis of the cross-section, the z-axis the minor axis. This coordinate system 
is used for both the input data and the results. 

 
Figure 2.8: Window 1.3 Cross-Sections 

Cross-Section Description 
The cross-sections defined in RSTAB are preset together with the assigned material numbers. 

To modify a cross-section, click the entry in column B selecting this box. Click [Cross-section 
Library] or [...] in the box or press function key [F7] to open the cross-section table of the 
current cross-section box (see the following figure). 

In this dialog box, you can select a different cross-section or a different cross-section table. To 
select a different cross-section category, click [Back to cross-section library] to access the gen-
eral cross-section library. 

Chapter 4.3 of the RSTAB manual describes how cross-sections can be selected from the library. 
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Figure 2.9: IS cross-sections in the cross-section library 

The new cross-section description can be entered in the cross-section box directly. If the data 
base contains an entry, STEEL SANS imports these cross-section parameters, too. 

A modified cross-section will be highlighted in blue. 

If cross-sections set in STEEL SANS are different from the ones used in RSTAB, both cross-
sections are displayed in the graphic in the right part of the window. The designs will be per-
formed with the internal forces from RSTAB for the cross-section selected in STEEL SANS. 

Cross-Section Type for Classification 
The cross-section type used for the classification is displayed, e.g. I-shape rolled, welded, box, 
round bar, etc. The cross-sections listed in [1] tables 3 and 4 can be designed plastically or elas-
tically depending on the class. Cross-sections that are not covered by the standard are classi-
fied as General. 

Max. Design Ratio 
This table column is displayed only after the calculation. It is a decision support for the optimi-
zation. By means of the displayed design ratio and colored relation scales, you can see which 
cross-sections are little utilized and thus oversized, or overloaded and thus undersized. 

Optimize 
You can optimize every cross-section from the library: For the RSTAB internal forces, the pro-
gram searches the cross-section in the same table that comes as close as possible to a user-
defined maximum ratio. The maximum ratio can be defined in the Details dialog box (see  
Figure 3.4, page 32). 

If you want to optimize a cross-section, open the drop-down list in column D or E and select 
the desired entry: From Current Row or, if available, From favorites 'Description'. Recommenda-
tions for the cross-section optimization can be found in chapter 7.2 on page 54. 



2  Input Data 

 16 Program STEEL SANS © 2014 Dlubal Software GmbH 

 

 

 

 

Remark 
This column shows remarks in the form of footers that are described in detail below the cross-
section list. 

A warning might appear before the calculation: Incorrect type of cross-section! This means that 
there is a cross-section that is not registered in the data base. This may be a user-defined cross-
section, or a SHAPE-THIN cross-section that has not been calculated yet. To select an appropri-
ate cross-section for design, click [Library] (see description after Figure 2.8). 

Member with tapered cross-section 
For tapered members with different cross-sections at the member start and member end, the 
module displays both cross-section numbers in two rows, in accordance with the definition in 
RSTAB. 

STEEL SANS also designs tapered members, provided that the cross-section at the start of the 
member has the same number of stress points as the cross-section at the end of the member. 
For example, the normal stresses are determined from the moments of inertia and the cen-
troidal distances of the stress points. If the start and the end cross-section of a tapered mem-
ber have a different number of stress points, the intermediate values cannot be interpolated. 
The calculation is possible neither in RSTAB nor in STEEL SANS. 

The cross-section's stress points including numbering can also be checked graphically: Select 
the cross-section in window 1.3 and click [Info]. The dialog box shown in Figure 2.10 appears. 

Info About Cross-Section 
In the dialog box Info About Cross-Section, you can view the cross-section properties, stress 
points and c/t-parts. 

 
Figure 2.10: Dialog box Info about Cross-Section 

In the right part of the dialog box, the currently selected cross-section is displayed. 
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The buttons below the graphic have the following functions: 

 

 

Table 2.2: Buttons of cross-section graphic 

Click [Details] to call up detailed information on stress points (distance to center of gravity, 
statical moments of area, normalized warping constants etc.) and c/t-parts. 

 
Figure 2.11: Dialog box Stress Points of UC 203x203x46 

Button Function 

 
Displays or hides the stress points 

 
Displays or hides the c/t-parts 

 
Displays or hides the numbering of stress points or c/t-parts 

 
Displays or hides the details of the stress points or c/t-parts (see Figure 2.11) 

 
Displays or hides the dimensions of the cross-section 

 
Displays or hides the principal axes of the cross-section 

 
Resets the full view of the cross-section graphic 
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2.4 Intermediate Lateral Restraints 
In window 1.4, you can define intermediate lateral restraints for members. STEEL SANS always 
assumes this kind of support to be perpendicular to the cross-section's minor axis z (see Figure 
2.8). Thus, it is possible to influence the members' effective lengths which are important for the 
design of column buckling and lateral torsional buckling. 

For the calculation, all intermediate lateral restraints are considered as torsional supports. 

 
Figure 2.12: Window 1.4 Intermediate Lateral Restraints 

In the upper part of the window, you can assign up to nine lateral supports for each member. 
The Settings section arranges the input in a column for an overview of the member selected 
above. 

To define the intermediate restraints of a member, select the Lateral Restraint check box in  
column A. To graphically select the member and to activate its row, click []. By selecting the 
check box, the other columns become available for you to enter the parameters. 

In column C, you specify the number of the intermediate restraints. Depending on the specifi-
cation, one or more of the following Intermediate Lateral Restraints columns for the definition 
of the x-locations are available. 

If the check box Relatively (0 … 1) is selected, the support points can be defined by relative-
input. The positions of the intermediate supports are determined from the member length 
and the relative distances from the member start. When the check box Relatively (0 ... 1) is 
cleared, you can define the distances manually in the upper table. 

In case of cantilevers, avoid intermediate restraints because such supports divide the member 
into segments. For cantilevered beams, this would results in segments with torsional restraints 
on one end each that are statically underdetermined. 
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2.5 Effective Lengths - Members 
Window 1.5 consists of two parts. The table in the upper part provides summarized information 
on the effective length factors Ky and Kz, the effective lengths  KyL and KzL, the lengths Lw and LT 
for torsional or torsional-flexural buckling and the member types of the beams to be designed. 
The effective lengths defined in RSTAB are preset. In the Settings section, further information is 
shown about the member whose row is selected in the upper section. 

Click the button [] to select a member graphically and to show its row. 

Changes can be made in the table as well as in the Settings tree. 

 
Figure 2.13: Window 1.5 Effective Lengths - Members 

The effective lengths for the column buckling about the minor axis z and the effective lengths 
for lateral-torsional buckling are aligned automatically with the entries of window 1.4 Interme-
diate Lateral Restraints. If intermediate restraints divide the member into member segments of 
different lengths, the program displays no values in the table columns G and J of window 1.5. 

The effective lengths can be entered manually in the table and in the Settings tree, or defined 
graphically in the work window after clicking [...]. This button is enabled when you click in the 
effective length box. 

The Settings tree manages the following parameters: 

• Cross-section 

• Length (actual length of the member) 

• Buckling Possible (cf column A)  

• Buckling About Major Axis y Possible (buckling lengths, cf columns B - D) 

• Buckling About Minor Axis z Possible (buckling lengths, cf columns E - G) 

• Lateral-Torsional Buckling Possible (LTB and torsional lengths, cf columns H - L) 

• Member Type (cf column M) 
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In this table, you can specify for the currently selected member whether to carry out a buckling 
or a lateral-torsional buckling analysis. In addition to this, you can adjust the Effective Length 
Factor for the respective lengths. When a coefficient is modified, the equivalent member 
length is adjusted automatically, and vice versa. 

You can also define the buckling length of a member in a dialog box. To open it, click the but-
ton shown on the left. It is located on the right below the upper table of the window.  

 
Figure 2.14: Dialog box Select Effective Length Coefficient 

In this dialog box, the values of the coefficient K can be defined that are to be assigned to the 
selected member(s). The Theoretical and Recommended values are described in [1], Annex E. 
Generally, it is possible to select predefined coefficients or to enter User-defined values. 

If a RSBUCK case calculated according to the eigenvalue analysis is already available, you can 
also select a Buckling mode to determine the factor.  

Buckling Possible 
A stability analysis for buckling and lateral buckling requires the ability of members to absorb 
compressive forces. Therefore, members for which such absorption is not possible because of 
the member type (for example tension members, elastic foundations, rigid connections) are 
excluded from design in the first place. The corresponding rows appear dimmed and a note is 
indicated in the Comment column. 

The Buckling Possible check boxes in table row A and in the Settings tree enable you to classify 
specific members as compression members or, alternatively, to exclude them from the design 
according to [1]. 
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Axis system 

 
 

Buckling About Axis y or Axis z 
With the check boxes in the Possible table columns, you decide whether a member is suscepti-
ble to buckling about the y-axis and/or z-axis. These axes represent the local member axes, 
with axis y being the "major" and axis z the "minor" member axis. The effective length coeffi-
cients Ky and Kz for buckling about the major or the minor axes can be selected freely. 

You can check the position of the member axes in the cross-section graphic in window 1.3 
Cross-Sections (see Figure 2.8, page 14). To access the RSTAB work window, click [View mode]. 
In the work window, you can display the local member axes by using the member's context 
menu or the Display navigator. 

 
Figure 2.15: Displaying the member axes in the Display navigator of RSTAB 

If buckling is possible about one or even both member axes, you can enter the buckling length 
coefficients as well as the buckling lengths in the columns C and D respectively F and G. The 
same is possible in the Settings tree. 

To specify the buckling lengths in the work window graphically, click [...]. This button becomes 
available when you click in a KL text box. 

When you define the effective length coefficient K, the program determines the effective 
length KL by multiplying the member length L by this buckling length coefficient. 

Lateral-Torsional and Torsional-Flexural Buckling 
Table column H controls whether a lateral-torsional and torsional-flexural buckling design is to 
be carried out. 

The effective lengths LW and LT depend on the settings of window 1.4 Intermediate Lateral Re-
straints. It is also possible to enter user-defined values into the columns J and K. The factor K 
(column I) is calculated from the lateral-torsional buckling length Lw of each member or mem-
ber segment. 

The effective length factors are to be determined according to [1], Table 1 or Table 2. 

In column L, three options are available for the calculation of the critical elastic moment Mcr. 

Mcr can be calculated according to the equation as specified in [1], clause 13.6 a) ii): 
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For that, it is necessary to define the Member Type in column M. 

By default, Mcr is determined by the Eigenvalue solver which takes into account the specific 
boundary conditions by using a finite model. The value of Mcr can also be entered Manually. 
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Member Type 
Column M provides two options to allocate the Member Type according to [1], clause 13.6. 

Comment 
In the last table column, you can enter your own comments for each member to describe, for 
example, the effective member lengths. 

Below the Settings table, you find the Set input for members No. check box. If selected, the set-
tings entered afterwards will be applied to the selected or to All members. Members can be  
selected by typing the member number or by selecting them graphically using the [] button. 
This option is useful when you want to assign the same boundary conditions to several mem-
bers. Please note that already defined settings cannot be changed subsequently with this 
function. 

2.6 Effective Lengths - Sets of Members 
Input window 1.6 controls the effective lengths for sets of members. It is only available if one 
or more sets of members have been selected in window 1.1 General Data. 

 
Figure 2.16: Window 1.6 Effective Lengths - Set of Members 

The concept of this window is similar to the one in the previous 1.5 Effective Lengths - Members 
window. In this window, you can enter the effective lengths of the set of members for buckling 
and lateral-torsional buckling as described in chapter 2.5. 
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2.7 Nodal Supports - Sets of Members 
This window is displayed only if you have selected at least one set of members for the design 
in the 1.1 General Data window. 

In STEEL SANS, the stability analysis for sets of members is performed with specific parameters. 
If, however, the Member-Like Input is set in the Details dialog box (see Figure 3.2, page 29), win-
dow 1.7 will not be displayed. In that case, the intermediate lateral restraints can be defined in 
window 1.4 by division points. 

 
Figure 2.17: Window 1.7 Nodal Supports - Set of Members 

To determine the critical factor of lateral-torsional buckling, a planar framework is created with 
four degrees of freedom for each node. The parameters are to be defined in window 1.7. The 
settings in the table refer to the current set of members which is selected in the add-on mod-
ule’s navigator on the left. 

The orientation of the axes in the set of members is important for the definition of nodal sup-
ports. The program checks the position of the nodes and internally defines, according to Fig-
ure 2.18 through Figure 2.21, the axes of the nodal supports for window 1.7. 

 
Figure 2.18: Auxiliary coordinate system for nodal supports – straight set of members 

If all members of a set of members lie in a straight line as shown in Figure 2.18, the local coor-
dinate system of the first member in the set of members corresponds to the equivalent coor-
dinate system of the entire set of members. 
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Figure 2.19: Auxiliary coordinate system for nodal supports – set of members in vertical plane 

If members of a set of members are not lying in a straight line, they must at least lie in the same 
plane. In Figure 2.19, they are lying in a vertical plane. In this case, the X’-axis is horizontal and 
oriented in direction of the plane. The Y’-axis is horizontal as well and defined perpendicular to 
the X’-axis. The Z’-axis is oriented perpendicularly downwards. 

 
Figure 2.20: Auxiliary coordinate system for nodal supports – set of members in horizontal plane 

If the members of a buckled set of members are lying in a horizontal plane, the X’-axis is de-
fined parallel to the X-axis of the global coordinate system. Thus, the Y’-axis is oriented in the 
opposite direction to the global Z-axis and the Z’-axis is directed parallel to the global Y-axis. 

 
Figure 2.21: Auxiliary coordinate system for nodal supports – set of members in inclined plane 

Figure 2.21 shows the general case of a buckled set of members: The members are not lying in 
one straight line but in an inclined plane. The definition of the X’-axis arises out of the intersec-
tion line of the inclined plane with the horizontal plane. Thus, the Y’-axis is defined perpendic-
ular to the X’-axis and directed perpendicular to the inclined plane. The Z’-axis is defined per-
pendicular to the X’- and Y’-axes. 
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2.8 Member End Releases - Sets of Members 
This window is displayed only if you have selected at least one set of members for the design 
in the 1.1 General Data window. Here, you can define releases for members and sets of mem-
bers that, due to structural reasons, do not transfer the locked degrees of freedom specified in 
window 1.7 as internal forces. This window refers to the current set of members (selected in 
the add-on module’s navigator on the left). 

Window 1.8 is not displayed when the Member-Like Input is set in the dialog box Details (see 
Figure 3.2, page 29) for sets of members. 

 
Figure 2.22: Window 1.8 Member End Releases - Set of Members 

In table column B, you define the Member Side to which the release should be assigned. You 
can also connect the releases to both member sides. 

In the columns C through F, you can define releases or spring constants to align the set of 
members model with the support conditions in window 1.7. 
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2.9 Serviceability Data 
This input window controls several settings for the serviceability limit state design. It is only 
available if you have set the according entries in the Serviceability Limit State tab of window 1.1 
General Data (see Figure 2.4, page 11). 

 
Figure 2.23: Window 1.9 Serviceability Data 

In column A, you decide whether you want to apply the deformation to single members, lists 
of members, or sets of members. 

In table column B, you enter the numbers of the members or sets of members that you want to 
design. You can also click [...] to select them graphically in the RSTAB work window. Then, the 
Reference Length appears in column D automatically. This column presets the lengths of the 
members, sets of members, or member lists. If required, you can adjust these values after se-
lecting the Manually check box in column C. 

Table column E defines the governing Direction for the deformation analysis. You can select 
the directions of the local member axes y and z (or u and v for unsymmetrical cross-sections). 

A precamber wc can be taken into account by using entries specified in column F. 

The Beam Type is of vital importance for the correct application of limit deformations. In table 
column G, you can select the girder to be a beam or a cantilever and decide which end should 
have no support. 

The settings of the Details dialog box determine whether the deformations are related to the 
undeformed initial model or to the shifted ends of members or sets of members (see Figure 3.3, 
page 31). 
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2.10 Parameters - Members 
The last input window controls additional design parameters for members. 

 
Figure 2.24: Window 1.10 Parameters - Members 

Cross-Sectional Area 
This column provides an option to reduce the cross-sectional area of specific members due to 
connections. In the Settings section below, the effective net area according to [1], clause 12.3.1 
and the shear lag factor according to [1], clause 12.3.3 can be defined. Those parameters can 
be set for the start and end nodes of each member. 

The effective cross-sectional areas are taken into account for the cross-section design of mem-
bers in tension. 
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3. Calculation 
 

3.1 Details 
Before you start the [Calculation], it is recommended to check the design details. You can open 
the corresponding dialog box in all windows of the add-on module by clicking [Details]. 

The Details dialog box contains the following tabs: 

• Ultimate Limit State 

• Stability 

• Serviceability 

• General 

3.1.1 Ultimate Limit State 

 
Figure 3.1: Dialog box Details, tab Ultimate Limit State 

Options 
The Plastic design acc. to 8.6 of hot-formed doubly symmetric I-sections (class 1) is possible, 
provided that the requirement given in [1], clause 8.6 a) is satisfied. 

Cross-sections that are assigned to class 1 or 2 are designed plastically in STEEL SANS. If you do 
not want to perform a plastic design, you can activate the Elastic Design for these cross-section 
classes, too. 
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The conservative general Elastic design is based on the analysis of stresses in stress points in-
clusive of VON MISES stresses. This method can be useful for cross-sections of complicated 
shapes or members with torsion. 

If the Shear design of solid cross-sections (flat or round bars) or the Shear buckling design of webs 
is not required, it can be disabled. 

The conservative General elastic design based on simple shear stress in the stress points can be 
activated to determine the stresses of x-locations where shear without bending occurs. 

Limit Internal Forces for Interaction 
The South African standard provides no exact recommendation how to design cross-sections 
with torsional moments. Therefore, it possible to ignore shear stress due to torsion if a user-
defined ratio of torsional shear stress τt and shear strength (product of resistance factor φ and 
ultimate shear stress) is not exceeded. 

3.1.2 Stability 

 
Figure 3.2: Dialog box Details, tab Stability 

Stability Analysis 
The Use check box controls whether to run, in addition to the cross-section checks, a stability 
analysis. If you clear the check box, the input windows 1.4, 1.5 and 1.6 will not be displayed. 

Second Order Effects Acc. to 13.8 
It is possible to Include effects from second order theory according to [1], clause 13.8 by increas-
ing the bending moments about the major and/or minor axes. Thus when you design, for ex-
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ample, a frame whose governing buckling mode is represented by lateral displacement, you 
can determine the internal forces according to linear static analysis and increase them with the 
factors according to [1], clause 13.8.2 and 13.8.4. If you increase the bending moment, it does 
not affect the flexural-buckling analysis which is performed by using the axial forces. 

Model Type 
According to [1], clause 13.8.2, the design of axial compression and bending depends on the 
fact whether the members are part of unbraced or braced frames. Please note that the settings 
of this check box are applied to all members of the design case. 

Lateral-Torsional Buckling 
If transverse loads are present, it is important to define where those forces are acting on the 
cross-section: Depending on the Load application point, transverse loads can be stabilizing or 
destabilizing, and, thus, can influence the critical elastic moment decisively. 

Sets of Members - Member-Like Input 
By default, the boundary conditions of every set of members are to be defined in windows 1.6, 
1.7 and 1.8. Alternatively, the "member-like input" can be applied: all sets of members are 
managed in the same manner as beams. Then, the input data of window 1.6 is internally trans-
formed to the boundary conditions required for the stability design. Windows 1.7 and 1.8 are 
not existent for the member-like input. As a rule, the member-like input is recommended for 
straight sets of members only. 

If the default Do not use member-like input is set, a general analysis is carried out. The support 
conditions have to be defined for each set of members in table 1.7. 

The option Use for all sets of members makes it possible to design sets of members in the same 
way as single members. This approach is applicable when every set of members corresponds 
to a single member model. Then the default values for simple girders are used to determine 
the support conditions β, uy, φx, φz and ω. 

It is possible to apply the member-like input only for straight sets of members which have the 
same cross-section (e.g. continuous beams). 

The last option to use the member-like input only for straight sets of members without interme-
diate restraints, according to the definition in RSTAB: Only sets of members which have RSTAB 
supports or restraints at their ends will be considered. This option can be used to design e.g. 
simple beams or cantilevers. Tables 1.7 and 1.8 are not displayed. Transverse beams that are 
connected at the intermediate nodes cannot be accounted for. 

Cross-Sections Fabrication Acc. to 13.3.1 
The factor n is relevant for the flexural buckling design according to [1], clause 13.3.1. This fac-
tor depends on the fabrication of the sections (state of residual stresses). Rolled or oxy-flame-
cut plates can be used to fabricate welded I and H sections. 

Please note that the type of fabrication which is set in this dialog section is applied to all cross-
sections of the design case. 

Limit Values for Special Cases 
To design non-symmetrical cross-sections for intended axial compression according to [1], 
clause 13.3, you can neglect small moments about the major and the minor axes using the set-
tings defined in this dialog section. 

In the same way, you can switch off small compression forces for the pure design of bending by 
defining a limit ratio for Cu to Cr,s,pl. 

 



3  Calculation 

 

 

31 Program STEEL SANS © 2014 Dlubal Software GmbH 

Intended torsion is not clearly specified in SANS 10162-1. If the torsional stresses do not exceed 
the shear stress ratio of 1 % (default), they are not considered in the stability design. The design 
is then carried for flexural buckling and lateral-torsional buckling. 

If one of the limits in this dialog section is exceeded, a note appears in the results window. No 
stability analysis is carried out. However, the cross-section checks are run independently. These 
limit settings are not part of the code [1]. Changing the limits is in the responsibility of the user. 

3.1.3 Serviceability 

 
Figure 3.3: Dialog box Details, tab Serviceability 

Deformation Related to 
The option fields control whether the maximum deformations are related to the shifted ends 
of members or sets of members (connection line between start and end nodes of the de-
formed system) or to the undeformed initial system. As a rule, the deformations are to be 
checked relative to the displacements in the entire structural system. 

Serviceability Limits (Deflections) Annex D 
In this dialog section, you can check and, if necessary, adjust the limit deformations of simple 
beams and cantilevers. The recommended maximum values for deflections at serviceability are 
contained in [1], Table D.1. 
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3.1.4 General 

 
Figure 3.4: Dialog box Details, tab General 

Cross-Section Optimization 
The optimization is targeted on the maximum design ratio of 100 %. If necessary, you can 
specify a different limit value in this input field. 

Check of Member Slendernesses 
In the two text boxes, you can specify the limit values λlimit in order to define member slender-
nesses. You can enter specifications separately for members with pure tension forces and 
members with bending and compression. 

The limit values are compared to the real member slendernesses in window 3.3. This window  
is available after the calculation (see chapter 4.8, page 41) if the corresponding check box is se-
lected in the Display Result Tables dialog box section. 

Display Result Tables 
In this dialog section, you can select the results windows including parts list that you want to 
display. Those windows are described in chapter 4 Results. 

The 3.3 Member Slendernesses window is inactive by default. 
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3.2 Start Calculation  
To start the calculation, click the [Calculation] button that is available in all input windows of 
the STEEL SANS add-on module. 

STEEL SANS searches for the results of the load cases, load and result combinations that are to 
be designed. If they cannot be found, the program starts the RSTAB calculation to determine the 
design relevant internal forces. 

You can also start the calculation in the RSTAB user interface: In the dialog box To Calculate 
(menu Calculate → To Calculate), design cases of the add-on modules like load cases and load 
combinations are listed. 

 
Figure 3.5: To Calculate dialog box 

If the STEEL SANS design cases are missing in the Not Calculated list, select All or Add-on Mod-
ules in the drop-down list at the end of the list. 

To transfer the selected STEEL SANS cases to the list on the right, use the button []. Click [OK] 
to start the calculation. 

To calculate a design case directly, use the list in the toolbar. Select the STEEL SANS design 
case in the toolbar list, and then click [Show Results]. 

 
Figure 3.6: Direct calculation of a STEEL SANS design case in RSTAB 

Subsequently, you can observe the design process in a separate dialog box. 



4  Results 

 34 Program STEEL SANS © 2014 Dlubal Software GmbH 

 

    

4. Results 
Window 2.1 Design by Load Case is displayed immediately after the calculation. 

 
Figure 4.1: Results window with designs and intermediate values 

The designs are shown in the results windows 2.1 to 2.5, sorted by different criteria. 

Windows 3.1 and 3.2 list the governing internal forces. Window 3.3 informs you about the 
member slendernesses. The last two results windows 4.1 and 4.2 show the parts lists sorted by 
member and set of members. 

Every window can be selected by clicking the corresponding entry in the navigator. To set the 
previous or next input window, use the buttons shown on the left. You can also use the func-
tion keys to select the next [F2] or previous [F3] window. 

Click [OK] to save the results. Thus you exit STEEL SANS and return to the main program. 

Chapter 4 Results describes the different results windows one by one. Evaluating and checking 
results is described in chapter 5 Evaluation of Results, page 44. 
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4.1 Design by Load Case 
The upper part of this window provides a summery, sorted by load cases, load combinations 
and result combinations of the governing designs. Furthermore, the list is divided in Ultimate 
Limit State Design and Serviceability Limit State Design results. 

The lower part gives detailed information on the cross-section properties, analyzed internal 
forces, and design parameters for the load case selected above. 

 
Figure 4.2: Window 2.1 Design by Load Case 

Description 
This column shows the descriptions of the load cases, load and result combinations used for 
the design. 

Member No. 
This column shows the number of the member that bears the maximum stress ratio of the 
designed loading. 

Location x 
This column shows the respective x-location where the member's maximum stress ratio oc-
curs. For the table output, the program uses the following member locations x: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB table 1.6) 

• Member division according to specification for member results (RSTAB dialog box  
Calculation Parameters, tab Global Calculation Parameters) 

• Extreme values of internal forces 

Design Ratio 
Columns D and E display the design conditions according to SANS 10165-1 [1]. 

The lengths of the colored bars represent the respective utilizations. 
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Design according to Formula 
This column lists the equations of the standard by which the designs have been performed. 

DS 
The final column provides information on the respective design-relevant design situation (DS): 
ULS (Ultimate Limit State) or SLS (Serviceability Limit State). 

4.2 Design by Cross-Section 

 
Figure 4.3: Window 2.2 Design by Cross-Section 

This window lists the maximum ratios of all members and actions selected for design, sorted 
by cross-section. The results are sorted by cross-section design and serviceability limit state 
design. 

If there is a tapered member, the results of both cross-section numbers are listed. 
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4.3 Design by Set of Members 

 
Figure 4.4: Window 2.3 Design by Set of Members 

This results window is displayed if you have selected at least one set of members for design. 
The window lists the maximum ratios sorted by set of members. 

The Member No. column shows the number of the one member within the set of members that 
bears the maximum ratio for the individual design criteria. 

The output by set of members clearly presents the design for an entire structural group (for 
example a frame). 
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4.4 Design by Member 

 
Figure 4.5: Window 2.4 Design by Member 

This results window presents the maximum ratios for the individual designs sorted by member 
number. The columns are described in detail in chapter 4.1 on page 35. 

4.5 Design by x-Location 

 
Figure 4.6: Window 2.5 Design by x-Location 
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This results window lists the maxima for each member at the locations x resulting from the 
division points defined in RSTAB: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB table 1.6) 

• Member division according to specification for member results (RSTAB dialog box  
Calculation Parameters, tab Global Calculation Parameters)  

• Extreme values of internal forces 

4.6 Governing Internal Forces by Member 

 
Figure 4.7: Window 3.1 Governing Internal Forces by Member 

For each member, this window displays the governing internal forces, i.e. those internal forces 
that result in the maximum utilization of each design. 

Location x 
At this x location of the member, the respective maximum design ratio occurs. 

Load Case 
This column displays the number of the load case, the load combination or result combination 
whose internal forces result in the maximum design ratios. 

Forces / Moments 
For each member, this column displays the axial and shear forces as well as the torsional and 
bending moments producing maximum design ratios in the respective ultimate limit state and 
serviceability limit state designs. 

Design According to Formula 
The final column provides information on the types of design and the equations by which the 
designs according to [1] have been performed. 
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4.7 Governing Internal Forces by Set of Members 

 
Figure 4.8: Window 3.2 Governing Internal Forces by Set of Members 

This window shows the internal forces that result in the maximum ratios of the design for each 
set of members. 
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4.8 Member Slendernesses 

 
Figure 4.9: Window 3.3 Member Slendernesses 

This results window is shown only when you have selected the respective check box in the  
Details dialog box (see Figure 3.4, page 32). 

The table lists the effective slendernesses of the designed members for both directions of the 
principal axes. They were determined depending on the type of load. At the end of the list, you 
find a comparison with the limit values that have been defined in the Details dialog box (see 
Figure 3.4, page 32). 

Members of the member type "Tension" or "Cable" are not included in this table. 

This window is displayed only for information. No design of the slendernesses is carried out. 
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4.9 Parts List by Member 
Finally, STEEL SANS provides a summary of all cross-sections that are included in the design 
case. 

 
Figure 4.10: Window 4.1 Parts List by Member 

By default, this list contains only the designed members. If you need a parts list for all members 
of the model, select the corresponding option in the Details dialog box (see Figure 3.4, page 32). 

Part No. 
The program automatically assigns item numbers to similar members. 

Cross-Section Description 
This column lists the cross-section numbers and descriptions. 

Number of Members 
This column shows how many similar members are used for each part. 

Length 
This column displays the respective length of an individual member. 

Total Length 
This column shows the product determined from the two previous columns. 

Surface Area 
For each part, the program indicates the surface area related to the total length. The surface 
area is determined from the Surface Area of the cross-sections that can be seen in windows 1.3 
and 2.1 to 2.5 in the cross-section information (see Figure 2.10, page 16). 
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Volume 
The volume of a part is determined from the cross-sectional area and the total length. 

Unit Weight 
The Unit Weight of the cross-section is relative to the length of one meter. For tapered cross-
sections, the program averages both cross-section masses. 

Weight 
The values of this column are determined from the respective product of the entries in column 
C and G. 

Total Weight 
The final column indicates the total mass of each part. 

Sum 
At the bottom of the list, you find a sum of the values in the columns B, D, E, F, and I. The last 
cell of the column Total Weight gives information about the total amount of steel required. 

4.10 Parts List by Set of Members 

 
Figure 4.11: Window 4.2 Parts List by Set of Members 

The last results window is displayed if you have selected at least one set of members for de-
sign. The table summarizes an entire structural group (for example a horizontal beam) in a 
parts list. 

Details on the various columns can be found in the previous chapter. If different cross-sections 
are used in the set of members, the program averages the surface area, the volume, and the 
cross-section weight. 
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5. Evaluation of Results 
The design results can be evaluated in different ways. For this, the buttons in the results win-
dows are very useful which are located below the upper tables.  

 
Figure 5.1: Buttons for evaluation of results 

These buttons have the following functions: 

Button Description Function 

 Ultimate Limit State Designs 
Turns on and off the results of the ultimate limit 
state design 

 
Serviceability Limit State 
Designs 

Turns on and off the results of the serviceability 
limit state design 

 New Result Combination 
Creates a result combination from the governing 
load cases and load combinations 

 Show Color Bars 
Turns on and off the colored reference scales in  
the results windows 

 

Filter Parameters 
Describes the filter criterion for the output in the 
tables:  Design ratios greater than 1, maximum 
value or user-defined limit 

 Apply Filter 
Displays only rows where the filter parameters are 
valid (ratio > 1, maximum, user-defined value) 

 Result Diagrams 
Opens the window Result Diagram on Member 
 chapter 5.2, page 47 

 Excel Export 
Exports the table to MS Excel / OpenOffice 
 chapter 7.4.3, page 57 
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 Member Selection 
Allows you to graphically select a member to  
display its results in the table 

 View Mode 
Jumps to the RSTAB work window to change the 
view 

Table 5.1: Buttons in results windows 2.1 through 2.5 

5.1 Results in the RSTAB Model 
To evaluate the design results, you can also use the RSTAB work window. 

RSTAB background graphic and view mode 
The RSTAB work window in the background is useful when you want to find the position of a 
particular member in the model: The member selected in the STEEL SANS results window is 
highlighted in the selection color in the background graphic. Furthermore, an arrow indicates 
the member's x-location that is displayed in the selected table row. 

 
Figure 5.2: Indication of the member and the current Location x in the RSTAB model 

If you cannot improve the display by moving the STEEL SANS module window, click [Jump to 
Graphic] to activate the View Mode: The program hides the module window so that you can 
modify the display in the RSTAB user interface. The view mode provides the functions of the 
View menu, for example zooming, moving, or rotating the display. The pointer remains visible. 

Click [Back] to return to the add-on module STEEL SANS. 

RSTAB work window 
You can also graphically check the design ratios in the RSTAB model. Click [Graphics] to exit 
the design module. In the RSTAB work window, the design ratios are now displayed like the  
internal forces of a load case. 

In the Results navigator, you can specify which design ratios of the service or ultimate limit 
state design you want to display graphically. 

To turn the display of design results on or off, use the [Show Results] button known from the 
display of internal forces in RSTAB. To display the result values, use the toolbar button [Show 
Values] to the right. 

As the RSTAB tables are of no relevance for the evaluation of design results, you can hide them. 

The design cases can be set by means of the list in the RSTAB menu bar. 
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To adjust the graphical representation of the results, you can select Results → Members in the 
Display navigator. The display of the design ratios is Two-Colored by default. 

 

Figure 5.3: Display navigator: Results → Members 

When you select a multicolor representation (options With/Without Diagram or Cross-Sections), 
the color panel becomes available. It provides the common control functions described in de-
tail in the RSTAB manual, chapter 3.4.6. 

 

Figure 5.4: Design ratios with display option Without Diagram 

This graphics of the design results can be transferred to the printout report (see chapter 6.2, 
page 50). 

To return to the STEEL SANS module, click [STEEL SANS] in the panel. 
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5.2 Result Diagrams 
You can also graphically evaluate a member's result distributions in the result diagram. 

To do this, select the member (or set of members) in the STEEL SANS results window by click-
ing in the table row of the member. Then open the Result Diagram on Member dialog box by 
clicking the button shown on the left. The button is located below the upper results table (see 
Figure 5.1, page 44). 

The result diagrams are also available in the RSTAB graphic. To display the diagrams, click 

Results → Result Diagrams for Selected Members 

or use the button in the RSTAB toolbar shown on the left. 

A window opens, graphically showing the distribution of the maximum design values on the 
member or set of members. 

 
Figure 5.5: Dialog box Result Diagram on Member 

Use the list in the toolbar above to choose the relevant STEEL SANS design case.  

The Result Diagram on Member dialog box is described in the RSTAB manual, chapter 9.5. 
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5.3 Filter for Results 
The STEEL SANS results windows allow you to sort the results by various criteria. In addition, 
you can use the filter options described in chapter 9.7 of the RSTAB manual to evaluate the de-
sign results graphically. 

You can use the Visibility options also for STEEL SANS (see RSTAB manual, chapter 9.7.1) to filter 
the members in order to evaluate them. 

Filtering designs 
The design ratios can easily be used as filter criteria in the RSTAB work window which you can 
access by clicking [Graphics]. To apply this filter function, the panel must be displayed. If it is 
not shown, click 

View → Control Panel (Color Scale, Factors, Filter) 

or use the toolbar button shown on the left. 

The panel is described in the RSTAB manual, chapter 3.4.6. The filter settings for the results 
must be defined in the first panel tab (Color spectrum). As this register is not available for the 
two-colored results display, you have to use the Display navigator and set the display options 
Colored With/Without Diagram or Cross-Sections first. 

 
Figure 5.6: Filtering design ratios with adjusted color spectrum 

As the figure above shows, the color spectrum can be set in such a way that only ratios higher 
than 0.50 are shown in a color range between blue and red. 

If you select the Display Hidden Result Diagram option in the Display navigator (Results → Mem-
bers), you can display all stress ratio diagrams that are not covered by the color spectrum. 
Those diagrams are represented by dotted lines. 
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Filtering members 
In the Filter tab of the control panel, you can specify the numbers of particular members to 
display their results exclusively, that is, filtered. This function is described in detail in the RSTAB 
manual, chapter 9.7.3. 

 

Figure 5.7: Member filter for the stress ratios of a hall frame 

Unlike the partial view function (Visibilities), the graphic displays the entire model. The figure 
above shows the design ratios of a hall frame. The remaining members are displayed in the 
model but are shown without design ratios.
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6. Printout 
 

6.1 Printout Report 
Similar to RSTAB, the program generates a printout report for the STEEL SANS results, to which 
graphics and descriptions can be added. The selection in the printout report determines what 
data from the design module will be included in the printout. 

The printout report is described in the RSTAB manual. In particular, chapter 10.1.3.5 Selecting 
Data of Add-on Modules describes how to select input and output data of add-on modules for 
the printout. 

For complex structural systems with many design cases, it is recommended to split the data 
into several printout reports, thus allowing for a clearly-arranged printout. 

6.2 STEEL SANS Graphic Printout  
In RSTAB, you can add every picture that is displayed in the work window to the printout re-
port or send it directly to a printer. In this way, you can prepare the design ratios displayed on 
the RSTAB model for the printout, too. 

The printing of graphics is described in the RSTAB manual, chapter 10.2. 

Designs in the RSTAB model 
To print the currently displayed graphic of the design ratios, click 

File → Print Graphic 

or use the toolbar button shown on the left. 

 
Figure 6.1: Button Print Graphic in RSTAB toolbar 

Result Diagrams 
You can also transfer the Result Diagram on Member to the report by using the [Print] button. It 
is also possible to print it directly. 

 
Figure 6.2: Button Print Graphic in the dialog box Result Diagram on Member 

The dialog box Graphic Printout opens (see figure on next page). 
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Figure 6.3: Dialog box Graphic Printout, tab General 

This dialog box is described in the RSTAB manual, chapter 10.2. The RSTAB manual also 
describes the Options and Color Spectrum tab. 

You can move a graphic anywhere within the printout report by using the drag-and-drop 
function. 

To adjust a graphic subsequently in the printout report, right-click the relevant entry in the 
navigator of the printout report. The option Properties in the context menu opens the dialog 
box Graphic Printout, offering various options for adjustment. 

 
Figure 6.4: Dialog box Graphic Printout, tab Options
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7. General Functions 
This chapter describes useful menu functions as well as export options for the designs. 

7.1 Design Cases 
Design cases allow you to group members for the design: In this way, you can combine groups 
of structural components or analyze members with particular design specifications (for exam-
ple changed materials, partial safety factors, optimization). 

It is no problem to analyze the same member or set of members in different design cases. 

To calculate a STEEL SANS design case, you can also use the load case list in the RSTAB toolbar. 

Create New Design Case 
To create a new design case, use the STEEL SANS menu and click 

File → New Case. 

The following dialog box appears: 

 
Figure 7.1: Dialog box New STEEL SANS Case 

In this dialog box, enter a No. (one that is still available) for the new design case. The corre-
sponding Description will make the selection in the load case list easier. 

Click [OK] to open the STEEL SANS window 1.1 General Data where you can enter the design 
data. 

Rename a Design Case 
To change the description of a design case, use the STEEL SANS menu and click 

File → Rename Case. 

The following dialog box appears: 

 
Figure 7.2: Dialog box Rename STEEL SANS Case 

In this dialog box, you can define a different Description as well as a different No. for the design 
case. 
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Copy a Design Case 
To copy the input data of the current design case, use the STEEL SANS menu and click 

File → Copy Case. 

The following dialog box appears: 

 
Figure 7.3: Dialog box Copy STEEL SANS Case 

Define the No. and, if necessary, a Description for the new case. 

Delete a Design Case 
To delete design cases, use the STEEL SANS menu and click 

File → Delete Case. 

The following dialog box appears: 

 
Figure 7.4: Dialog box Delete Cases 

The design case can be selected in the list Available Cases. To delete the selected case,  
click [OK]. 
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7.2 Cross-Section Optimization 
The design module offers you the option to optimize overloaded or little utilized cross-sections. 
To do this, select in column D or E of the relevant cross-sections in the 1.3 Cross-Sections win-
dow whether to determine the cross-section From the current row or the user-defined Favorites 
(see Figure 2.8, page 14). You can also start the cross-section optimization in the results win-
dows by using the context menu 

 
Figure 7.5: Context menu for cross-section optimization 

During the optimization process, the module determines the cross-section that fulfills the anal-
ysis requirements in the most optimal way, that is, comes as close as possible to the maximum 
allowable design ratio specified in the Details dialog box (see Figure 3.4, page 32). The required 
cross-section properties are determined with the internal forces from RSTAB. If another cross-
section proves to be more favorable, this cross-section is used for the design. Then, the graphic 
in window 1.3 shows two cross-sections: the original cross-section from RSTAB and the opti-
mized one (see Figure 7.7). 

For a parameterized cross-section, the following dialog box appears when you select 'Yes' from 
the drop-down list. 

 
Figure 7.6: Dialog box Welded Cross-Sections - I symmetric : Optimize 
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By selecting the check boxes in the Optimize column, you decide which parameter(s) you want 
to modify. This enables the Minimum and Maximum columns, where you can specify the upper 
and lower limits of the parameter. The Increment column determines the interval in which the 
size of the parameter varies during the optimization process. 

If you want to Keep current side proportions, select the corresponding check box. In addition, 
you have to select at least two parameters for optimization. 

Cross-sections based on combined rolled cross-sections cannot be optimized. 

Please note that the internal forces are not automatically recalculated with the changed cross-
sections during the optimization: It is up to you to decide which cross-sections should be 
transferred to RSTAB for recalculation. As a result of optimized cross-sections, internal forces 
may vary significantly because of the changed stiffnesses in the structural system. Therefore, it 
is recommended to recalculate the internal forces of the modified cross-section data after the 
first optimization, and then to optimize the cross-sections once again. 

You can export the modified cross-sections to RSTAB: Go to the 1.3 Cross-Sections window, and 
then click 

Edit → Export All Cross-Sections to RSTAB. 

Alternatively, you can use the context menu in window 1.3 to export optimized cross-sections 
to RSTAB. 

 
Figure 7.7: Context menu in window 1.3 Cross-Sections 

Before the modified cross-sections are transferred to RSTAB, a security query appears as to 
whether the results of RSTAB should be deleted. 

 
Figure 7.8: Query before transfer of modified cross-sections to RSTAB 

By confirming the query and then starting the [Calculation] in the STEEL SANS module, the 
RSTAB internal forces as well as the designs will be determined in one single calculation run. 

If the modified cross-sections have not been exported to RSTAB yet, you can import the origi-
nal cross-sections in the design module by using the options shown in Figure 7.7. Please note 
that this option is only available in window 1.3 Cross-sections. 
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If you optimize a tapered member, the program modifies the member start and end. Then it 
linearly interpolates the second moments of area for the intermediate locations. As these mo-
ments are considered with the fourth power, the designs may be inaccurate if the depths of 
the start and end cross-section differ considerably. In such a case, it is recommended to divide 
the taper into several members, thus manually modeling the taper layout. 

7.3 Units and Decimal Places 
Units and decimal places for RSTAB and the add-on modules are managed in one dialog box. 
In STEEL SANS, you can use the menu to define the units. To open the corresponding dialog 
box, click 

Settings → Units and Decimal Places. 

The program opens the following dialog box that you already know from RSTAB. STEEL SANS 
will be preset in the list Program / Module. 

 
Figure 7.9: Dialog box Units and Decimal Places 

You can save the settings as a user profile to reuse them in other models. These functions are 
described in the RSTAB manual, chapter 11.1.3. 
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7.4 Data Transfer 
7.4.1 Export Material to RSTAB 
If you have adjusted the materials in STEEL SANS for design, you can export the modified ma-
terials to RSTAB in a similar manner as you export members and cross-sections: Open window 
1.2 Materials, and then click 

Edit → Export All Materials to RSTAB. 

You can also export the modified materials to RSTAB by using the context menu of window 1.2. 

 
Figure 7.10: Context menu of window 1.2 Materials 

Before the modified materials are transferred to RSTAB, a security query appears as to whether 
the results of RSTAB should be deleted. When you have confirmed the query and then start the 
[Calculation] in STEEL SANS, the RSTAB internal forces and designs are determined in one sin-
gle calculation run. 

If the modified materials have not been exported to RSTAB yet, you can transfer the original 
materials to the design module, using the options shown in Figure 7.10. Please note, however, 
that this option is only available in window 1.2 Materials. 

7.4.2 Export Effective Lengths to RSTAB 
If you have adjusted the materials in STEEL SANS for design, you can export the modified mate-
rials to RSTAB in a similar manner as you export cross-sections: Open window 1.5 Effective 
Lengths - Members, and then click 

Edit → Export All Effective Lengths to RSTAB. 

or use the corresponding option on the context menu of window 1.5. 

 
Figure 7.11: Context menu of window 1.5 Effective Lengths - Members 

Before the modified materials are transferred to RSTAB, a security query appears as to whether 
the results of RSTAB should be deleted. 

If the modified effective lengths have not been exported to RSTAB yet, you can retransfer the 
original effective lengths to the design module, using the options shown in Figure 7.11. Please 
note, however, that this option is only available in window 1.5 Effective Lengths - Members and 
1.6 Effective Lengths - Sets of Members. 

7.4.3 Export Results 

The STEEL SANS results can also be used by other programs. 

Clipboard 
To copy cells selected in the results windows to the Clipboard, press the keys [Ctrl]+[C]. To in-
sert the cells, for example in a word-processing program, press [Ctrl]+[V]. The headers of the 
table columns will not be transferred. 
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Printout report 
You can print the data of the STEEL SANS add-on module into the global printout report (see 
chapter 6.1, page 50) for export. Then, in the printout report, click 

File → Export to RTF. 

The function is described in the RSTAB manual, 10.1.11. 

Excel / OpenOffice 
STEEL SANS provides a function for the direct data export to MS Excel, OpenOffice.org Calc or 
the file format CSV. To open the corresponding dialog box, click 

File → Export Tables. 

The following export dialog box appears 

 
Figure 7.12: Dialog box Export - MS Excel 

When you have selected the relevant parameters, you can start the export by clicking [OK].  
Excel or OpenOffice will be started automatically, i.e. they do not have to be opened first. 

 
Figure 7.13: Results in Excel 
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8. Example 
 

Column with Biaxial Bending 

In this example, the stability design of flexural buckling and lateral-torsional buckling is carried out 
by analyzing the relevant interaction conditions according to [1]. 

Design values 

System and loads 

 

Figure 8.1: System and design loads (γ-fold) 

Internal forces according to linear static analysis  

             
   P   Muoy   Muoz    Vy    Vz 

Figure 8.2: Internal Forces 

qz 

2 m 

2 m 

Fy 

N 

z 

y 

Design values of static loads: 

Nd = 300 kN 
qz,d = 5.0 kN/m 
Fy,d = 7.5 kN 

 
Cross-section: UC 152x152x37 
 
Material:  Steel S 235 

4 m 
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Design location (decisive location x) 

The design is performed for all locations x (see chapter 4.5) of the member. The following 
internal forces act in the decisive location at x = 2.00 m:  

P = –300.00 kN        Muoy = 10.00 kNm        Muoz = 7.50 kNm       Vy = 3.75 kN       Vz = 0.00 kN 

Cross-section properties UC 152x152x37, Steel S 235 

 Property Symbol Value  Unit 

 Area of cross-section Ag 47.11 cm2 

 Moment of inertia Iy 2210.00 cm4 

 Moment of inertia Iz 7060.00 cm4 

 Radius of inertia ry 6.85 cm 

 Radius of inertia  rz 3.87 cm 

 Polar radius of gyration ro 7.86 cm 

 Polar radius of gyration ro,M 41.90 cm 

 Cross-section weight G 37.00 kg/m 

 Torsional constant J 19.70 cm4 

 Warping constant Ca 399000.00 cm6 

 Elastic section modulus Sy 274.00 cm3 

 Elastic section modulus Sz 91.50 cm3 

 Plastic section modulus Zy 309.00 cm3 

 Plastic section modulus Zz 140.00 cm3 

Flexural buckling about the minor axis (⊥ to z-z axis) 
Elastic flexural buckling stress 
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Cross-section type acc. to Table 3 is “compact”: Ae = Ag 

Slenderness ratio 
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The appropriate constant n is given in [1], clause 13.3.1. 

n = 1.34 for hot-rolled I-section 

Factored member resistance in compression 

( ) ( ) kN04.522127.1123547119.01fAC
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Result values from STEEL SANS calculation 

Compression Axial Force Cu 300.00 kN   

Factored Compression Resistance 
of Section Cr,s 996.38 kN  13.3 

Yield Strength fy 235 MPa  5.1 

Modulus of Elasticity E 200000 MPa   

Gross Area Ag 4711 mm2   

Second Moment of Area Iz 7060000 mm4   

Radius of Gyration rz 38.712 mm   

Effective Length Le,z 4000 mm   

Geometrical Slenderness Ratio λg,z 103.327    

Elastic Flexural Buckling Load Ce,z 870.99 kN  13.3.1 

Elastic Flexural Buckling Stress fe,z 184.885 MPa  13.3.1 

Slenderness Ratio λz 1.127   13.3.1 

Cross-Section Fabrication Factor n 1.340   13.3.1 

Resistance Factor Ф 0.900   13.1 

Factored Member Resistance Cr,m,z 521.82 kN  13.3.1 

Design Ratio η 0.575   ≤ 1 13.3.1 

Flexural buckling about the major axis (⊥ to y-y axis) 
Elastic flexural buckling stress 
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Elastic flexural buckling load 
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Cross-section type acc. to Table 3 is "compact": Ae = Ag 

Slenderness ratio 
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The appropriate constant n is given in [1], clause 13.3.1. 

n = 1.34 for hot-rolled I-section 

Factored member resistance in compression 

( ) ( ) kN86.819637.0123547119.01fAC
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Result values from STEEL SANS calculation 

Compression Axial Force Cu 300.00 kN   

Factored Compression Resistance 
of Section Cr,s 996.38 kN  13.3 

Yield Strength fy 235 MPa  5.1 

Modulus of Elasticity E 200000 MPa   

Gross Area Ag 4711 mm2   

Second Moment of Area Iy 22100000 mm4   

Radius of Gyration ry 68.492 mm   

Effective Length Le,y 4000 mm   

Geometrical Slenderness Ratio λg,y 58.401    

Elastic Flexural Buckling Load Ce,y 2726.48 kN  13.3.1 

Elastic Flexural Buckling Stress fe,y 578.747 MPa  13.3.1 

Slenderness Ratio λy 0.637   13.3.1 

Cross-Section Fabrication Factor N 1.340   13.3.1 

Resistance Factor Ф 0.900   13.1 

Factored Member Resistance Cr,m,y 819.73 kN  13.3.1 

Design Ratio η 0.366   ≤ 1 13.3.1 

Lateral-torsional buckling 

Critical elastic moment acc. to [1], clause 13.6 

The critical elastic moment of the unbraced member is given by the formula in clause 13.6 a) ii). 
The cross-section shape is doubly symmetric – class 1. The member is considered as a simply 
supported beam. 
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 where κ = 0.00 and ω2 = 1.00. 

Factored moment resistance acc. to [1], clause 13.5 

Nominal moment plastic resistances acc. to [1], clause 13.5 a) 

UC 152x152x37, cross-section class acc. to Table 4 is "1": 

kNm62.72235309000fZM yy,ply,p =⋅=⋅=  

kNm9.32235140000fZM yz,plz,p =⋅=⋅=  
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Factored moment resistance of member 

If 
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Interaction of biaxial bending and compression 
The determination of the design ratio is given in [1], clause 13.8.2. To calculate the final design 
ratio, we need to determinate the values of the interaction factors U1y, U1z and β. These values 
are calculated according to [1], clause 13.8.4 and 13.8.5. We consider the member as "braced 
frame".

 { } { } 85.085.0;127.14.06.0min85.0;4.06.0min z =⋅+=λ⋅+=β
 The member is subjected to a distributed load in z-axis (ω1y = 1.00) and a concentrated load in 

y-axis (ω1z = 0.85), see [1] clause 13.8.5 b) and c). 
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Interaction design ratio acc. to 13.8.2 (a) – cross-sectional strength 
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Interaction design ratio acc. to 13.8.2 (b) – overall member strength 
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Interaction design ratio acc. to 13.8.2 (c) – lateral-torsional buckling strength 
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Result values from STEEL SANS calculation 

Compression Axial Force Cu 300.00 kN   

Bending Moment Mu,y 10.00 kNm   

Maximum Bending Moment Mu,y,segm 10.00 kNm   

Bending Moment Mu,z 7.50 kNm   

Maximum Bending Moment Mu,z,segm 7.50 kNm   

Yield Strength fy 235 MPa  5.1 

Plastic Moment Resistance of Section Mp,y 72.62 kNm   

Factored Moment Resistance of Section Mr,s,y 65.35 kNm  13.5 

Plastic Moment Resistance of Section Mp,z 32.90 kNm   

Factored Moment Resistance of Section Mr,s,z 29.61 kNm  13.5 

Modulus of Elasticity E 200000 MPa   

Shear Modulus G 77000 MPa   

Second Moment of Area Iz 7060000 mm4   

Torsional Constant J 197000 mm4   

Warping Constant Cw 3.99E+10 mm6   

Segment Length L 4000 mm   

Effective Length Factor K 1.000   Tab. 1 or 2 

Effective Length Le 4000 mm  10.2 

Coefficient ω2 1.000   13.6 

Critical Elastic Moment Mcr 132.29 kNm   

Factored Moment Resistance of Member Mr,m,y 63.61 kNm  13.6 

Elastic Flexural Buckling Load Ce,y 2726.48 kN  13.3.1 

Coefficient ω1,y 1.000   13.8.5 

Factor of Second Order Effect U1,y 1.124   13.8.4 

Design Component for My ηMy 0.150  ≤ 1 13.8.2 

Factor β 0.850   13.8.2 

Elastic Flexural Buckling Load Ce,z 870.99 kN  13.3.1 

Coefficient ω1,z 0.850   13.8.5 

Factor of Second Order Effect U1,z 1.297   13.8.4 

Design Component for Mz ηMz 0.279  ≤ 1  

Gross Area Ag 4711 mm2   

Factored Compression Resistance of Section Cr,s 996.38 kN  13.3 

Factored Member Resistance Cr,m,y 819.73 kN  13.3.1 

Factored Member Resistance Cr,m,z 521.82 kN  13.3.1 

Factored Member Resistance Cr,m,T 850.35 kN  13.3.2 

Factored Member Resistance Cr,m 521.82 kN  13.3 

Design Component for N ηN 0.575  ≤ 1 13.8.2 

Resistance Factor Ф 0.900   13.1 

Design Ratio η1 0.644  ≤ 1 13.8.2 

Design Ratio η2 1.000  ≤ 1 13.8.2 

Design Ratio η3 1.004  ≥ 1 13.8.2 

Design Ratio η 1.004  ≥ 1  
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